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Computer - 1

CHAPTER-1
My Computer

A.	Write the missing letters in the boxes to 
complete them.

	 KEYBOARD		 PRINTER
	 MOUSE		 SPEAKERS
	 MONITOR
B.	1.	 music	 2.	keys
	 3.	 Mouse	 4.	central
	 5.	 clock
C.	1.	 T	 2.	F
	 3.	 T	 4.	T
	 5.	 T
D.	Do your self
E.	Mouse		 Monitor
	 Keyboard		 Printer

	 CPU		 Speaker

CHAPTER-2
Uses of a Computer

A. 1.	 (a) Speakers
	 2.	 (b) keeping account records
	 3.	 (a) poems
	 4.	 (b) Computer
	 5.	 (b) Keyboard
B. 1.	 computer	 2.	 calculations
	 3.	 billing	 4.	 ticket
	 5.	 patients
C. 1.	 F	 2.	 F
	 3.	 T	 4.	 T
	 5.	 T
D. 1.	 3	 2.	 5
	 3.	 3	 4.	 5
	 5.	 3	 6.	 5
E.	SCHOOL		  HOSPITAL
	 AIRPORT		  BANK
	 HOTEL
F.	 Do your self

CHAPTER-3
Keyboard

A.	1.	 (b)	 2.	 (b)
B.	1.	 keyboard	 2.	 enter
	 3.	 spacebar key	 4.	 backspace key
	 5.	 number key
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 T
D.	1.	 Alphabet keys	 2.	 Number keys
	 3.	 Arrow keys	 4.	 Special keys
E.	1.	 c	 4.	 f
	 2.	 e	 5.	 b
	 3.	 a	 6.	 d
F.	 1.	 Capslock	 2.	 Delete
	 3.	 Backspace	 4.	 Enter
	 5.	 Spacebar	 6.	 Shift

CHAPTER-4
MOUSE

A.	Do your self
B.	1.	 wire	 2.	 click
	 3.	 mousepad	 4.	 scroll wheel
	 5.	 two
C.	1.	 F	 2.	 F
	 3.	 T	 4.	 T
	 5.	 T
D.	1.	 BUTTON	 2.	 MOUSE
	 3.	 CLICK	 4.	 SCROLL
	 5.	 MOUSE PAD
E.	Rightbutton		  Scrollwheel
	 Pointer		  Wire
	 Leftbutton		  Mouse pad

CHAPTER-5
Notepad

A.	1.	 (b) Text editor	 2.	 (a) Save
	 3.	 (b) Insert	 4.	 (b) Font
	 5.	 (c) .txt
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B.	1.	 cursor	 2.	 keyboard
	 3.	 editing	 4.	 character
	 5.	 .txt
C.	1.	 F	 2.	 F
	 3.	 T	 4.	 T
	 5.	 F
D.	1.	 Click on Start Button
	 2.	 Click on All apps
	 3.	 Click on Window Accessories
	 4.	 Click on Notepad.
E.	1.	 Note pad is a software that is used for 

typing text on the computer.
	 2.	 From cursor the text starts to appear 

while typing.
	 3.	 Yes, we can write our name in Notepad.

	 4.	 No, we can not draw a picture in 
Notepad.

	 5.	 After typing, save the file by clicking 
the file tab and then click on the save 
option to save the document.

Test Paper
A.	1.	 (b) Computer
	 2.	 (b) Backspace
	 3.	 (b) Text-editor
B.	1.	 music	 2.	 computer
	 3.	 enter	 4.	 mousepad
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 F
D.	Do your self


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Computer - 2

CHAPTER-1
My Computer

A.	1.	 (d) Personal computer
	 2.	 (d) It can take decisions
	 3.	 (c) Remember everything
	 4.	 (d) All of these
	 5.	 (b) electricity
B.	1.	 Desktop	 2.	 electricity
	 3.	 Palmtop	 4.	 Tablet
	 5.	 decision
C.	1.	 F	 2.	 F
	 3.	 T	 4.	 T
	 5.	 T
D.	1.	 MISTAKES	 2.	 FEELINGS
	 3.	 ELETRICITY	 4.	 TIRED

E.	Do your self.

CHAPTER-2
Computing Advantages

and Manners
A.	1.	 fast	 2.	 decision

	 3.	 clothes	 4.	 wet

	 5.	 electricity

B.	1.	 F	 2.	 T

	 3.	 F	 4.	 T
	 5.	 T
C.	1.	 3	 2.	 3
	 3.	 3	 4.	 3
D.	Do your self
E.	 Advantages
	 1.	 Accuracy	 2.	 Storage capabilities
	 3.	 Multitasking	 4.	 Diligent

Disadvantages
	 1.	 Not a thinking Machine.

	 2.	 It cannot take any decision by itself.
	 3.	 It has no emotions or feelings.
	 4.	 It needs electricity to work.

CHAPTER-3
Computer in our Daily Life

1.	1.	 HOSPITAL

	 2.	 SHOPPING, MALL
	 3.	 SCHOOL	 4.	 BANK
B.	1.	 car, airplanes	 2.	 bank
	 3.	 home	 4.	 satellites
	 5.	 printing
C.	1.	 T	 2.	 F
	 3.	 F	 4.	 T
	 5.	 T

D.	1.	 Do your self.

E.	HOME		 AIRPORT

	 SCHOOL		 BANK

	 SHOP		 HOSPITAL

	 RAILWAY

CHAPTER-4
Paint

A.	1.	 size	 2.	 shape
	 3.	 background
	 4.	 Drawing Area	 5.	 Line
B.	1.	 T	 2.	 T
	 3.	 F	 4.	 T
	 5.	 F
C.	2, 1, 4, 3
D.	Do your self.
E.	Do your self.
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CHAPTER-5
Ms Word

A.	1.	 WORD	 2.	RIBBON

	 3.	 PROGRAM	 4.	MICROSOFT

B.	1.	 Microsoft	 2.	 Ribbon

	 3.	 MS Word	 4.	 close

	 5.	 File

C.	1.	 T	 2.	 T

	 3.	 T	 4.	 F

	 5.	 T

D.	Do your self.

E.	1.	 Quick Access Toolbar.

	 2.	 Document 1 - Microsoft Word

Test Paper
A.	1.	 HOSPITAL
	 2.	 SHOPPING MALL
	 3.	 SCHOOL	 4.	 BANK

B.	1.	 Desktop	 2.	 decision

	 3.	 computer screen with wet hands

	 4.	 car	 5.	 Microsoft

C.	1.	 F	 2.	 F

	 3.	 T	 4.	 F

	 5.	 T

D.	Do your self

E.	1.	 WORD	 2.	RIBBON

	 3.	 PROGRAM	 4.	ISCROSOFT


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Computer - 3

CHAPTER-1
Operating a Computer

A.	1.	 (b) UPS
	 2.	 (c) Switch on the main power button
	 3.	 (a) Booting
	 4.	 (b) Switch of the UPS
	 5.	 (c) Desktop
B.	Do your self
C.	Do your self
D.	Do your self
E.	1.	 UPS	 2.	 Booting
	 3.	 Shut-down	 4.	 Desktop

CHAPTER-2
Hardware & Software

A.	1.	 (c) Input	 2.	 (a) Output
	 3.	 (b) Processing	 4.	 (b) Drawing
B.	1.	 software	 2.	 Output
	 3.	 software	 4.	 Input
	 5.	 software
C.	1.	 T	 2.	 F	 3.	 T
	 4.	 T	 5.	 F
D.	1.	 Input-Processing-Output
	 2.	 Input refers to any information or 

data that is sent to a computer for 
processing.

	 3.	 Output is the information that comes 
after processing input information.

	 4.	 Hardware is the collection of all parts 
of a computer that we can touch and 
see.

E.	Take some potatoes
	 Cut them and fry them fryer.
	 Potato chips are made.

CHAPTER-3
Computer Devices

A.	1.	 (a) Input	 2.	 (b) Joystick
	 3.	 (a) Pen drive	 4.	 (a) Printer
	 5.	 (a) Input
B.	1.	 F	 2.	 T	 3.	 T	 4.	 T   	 5.	 T

C.	1-d, 2-f, 3-e, 4-a, 5-b, 6-c
D.	1.	 Digital Video Disc
	 2.	 Compact Disc Read Only Memory
	 3.	 Visual Display Unit
E.	1.	 SPEAKERS	 2.	 JOYSTICK
	 3.	 MOUSE	 4.	 PROJECTOR
	 5.	 PENDRIVE
F.	 Do your self.

CHAPTER-4
Editing in MS Paint

A.	1.	 (b) Cut and Paste	 2.	 (c) Image
	 3.	 (b) Select all	 4.	 (b) Clipboard
	 5.	 (b) Quick access toolbar
B.	1.	 Free-form selection	 2.	 Ctrl + W
	 3.	 Select	 4.	 Undo
	 5.	 Redo
C.	1.	 F	 2.	 F	 3.	 T	 4.	 F	 5.	 F
D.	1.	 (i)	 Click the Select in the Image 

group on the Home tab. 
		  (ii)	 Press the left mouse button and 

drag over the area that you want 
to rotate. 

		  (iii)	 Click on rotate button in the 
image group and select the 
desired option.

	 2.		 Select tool in the image group on the 
home tab is used to select a portion of 
the drawing or whole drawing that we 
want to edit. 

	 3.	 Copying :
	 (i)	 Click Select in the Image group on the 

Home tab.
	 (ii)	Select the picture using selection tool. 
	 (iii)	Now, click on the Home tab and then 

click on copy option of clipboard 
group. 

	 (iv) 	The selected image will be copied to 
clipboard. 

	 (v)	 Now click on the Paste option of 
Clipboard group. 

	 (vi)	A copy of the picture will appear on 
the top-left corner of our drawing.
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	 (vii)	Click and drag this new picture to the 

area where you want to place it.

CHAPTER-5
WordPad

A.	1.	 (c) Quick Access	 2.	 (c) Title bar
	 3.	 (a) Bold	 4.	 (b) double
	 5.	 (c) Typing
B.	1.	 T	 2.	 F	 3.	 T	 4.	 T	       5.	T
C.	Do your self.
D.	1.	 Font	 2.	 Ribbon	 3.	 Cursor
	 4.	 Underline	 5.	 Italic.
E.	1.	 WordPad is a program that is used for 

typing text on a computer.
	 2.	 Selecting Text in Wordpad

To Select Action to be done

A single word Double click the word.
A single 
paragraph

Triple click a word within 
the paragraph or double 
click in the margin to the 
left of the paragraph.

Any part of a 
document

Drag the pointer over the 
text that you want to select.

A large 
selection

Click at the beginning of 
the text that you want to 
select, press and hold Shift, 
then click at the end of the 
text that you want to select.

The entire 
document

Triple click in the left 
margin, press Ctrl+A, or 
click Select all button on 
the Home tab.

	  3.	 There are two methods to close the 
wordpad document:

		  Method-1: By clicking the Close (×) 
button from the top right hand side of 
wordpad window.

		  Method-2: By clicking the Close 
option from the wordpad menu.

CHAPTER-6
Artificial Intelligence

A.	1.	 intelligent	 2.	 smart watch
	 3.	 chatbot	 4.	 driver-less
	 5.	 portable

B.	1.	 T	 2.	 F	 3.	 F	 4.	 F	       5.	T
C.	Do yourself.
D.	1.	 Al technologies help us to perform 

work more efficiently and accurately.
	 2.	 Smart-phone, Robots, Smartwatch, 

Chatbot, Smart speakers.
	 3.	 Many companies have developed 

smart toys that use AI technology to 
provide interactive and educational 
experiences for kids.

	 4.	 Al helps to reduce human error, assist 
medical staffs and provide patients 
services 24/7.

		  The potential for AI in healthcare 
is immense, as it has the ability to 
apply problem-solving techniques that 
humans could not do alone.	

Test Paper
A.	1.	 (b) UPS	
	 2.	 (b) Switch off the UPS
	 3.	 (a) Input
	 4.	 (b) Cut & Paste
	 5.	 (c) Input
	 6.	 (a) Input
	 7.	 (b) Clipboard

B.	1.	 Free-form selection	 2.	 Ctrl + W
	 3.	 intelligent	 4.	 Chatbot
C.	1.	 F	 2.	 T	 3.	 F	 4.	 F
D.	1.	 d	 2.	 f	 3.	 e	 4.	 a
	 5.	 b	 6.	 c

E.	1.	 Input-Processing-Output.
	 2.	 Hardware is the collection of all parts 

of a computer that we can touch and 
see.

	 3.		 Select tool in the image group on the 
home tab is used to select a portion of 
the drawing or whole drawing that we 
want to edit.

qq
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Computer - 4

CHAPTER-1
Types of Computers

A.	1.	 (b) Medium types of computers
	 2.	 (a) Microcomputers
	 3.	 (c) banks
	 4.	 (c) Supercomputers
B.	1.	 Microcomputer	 2.	 Desktop
	 3.	 Hybrid
	 4.	 Palmtop computer	 5.	 Digital
C.	1.	 F	 2.	 F
	 3.	 T	 4.	 F
	 5.	 T
D.		 Size and capacity wise
	 1.	 Supercomputer
	 2.	 Mainframe computer
	 3.	 Minicomputer
	 4.	 Microcomputer

Purpose wise
	 1.	 General purpose	
	 2.	 Special purpose

Type wise
	 1.	 Anolog computer
	 2.	 Digital computer
	 3.	 Hybrid computer
E.	Desktop		  Supercomputer
	 Tablet PC

CHAPTER-2
Hardware & Software

A.	1.	 (b) MS Windows
	 2.	 (b) Input Devices
	 3.	 (c) Printer	 4.	 (a) Storage Devices
B.	1.	 user	 2.	 hardware
	 3.	 Input	 4.	 Operating System
	 5.	 application software
C.	1.	 T	 2.	 T
	 3.	 F	 4.	 T
	 5.	 T

D.	 Hardware
	 Monitor
	 Speaker
	 Printer
	 Keyboard
	 Webcam
	 Scanner
	 Microphone
	 DVD

Software
	 MS Word
	 MS Excel
	 MS Powerpoint
	 Youtube
E.	(i)	 c	 (ii)	 d
	 (iii)	e	 (iv)	 b
	 (v)	 f	 (vi)	 a

CHAPTER-3
Introduction to Windows 10

A.	1.	 (b) Left	 2.	 (b) open
	 3.	 (c) taskbar	 4.	 (a) attractive
B.	1.	 Microsoft	 2.	 booting
	 3.	 desktop	 4.	 Icons
	 5.	 Cortana
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 T
	 5.	 F
D.	Username (Folder)		  Network
	 Microsoft Edge		  This PC
	 Recycle Bin
E.	1.	 Windows 10 is a GUI (Graphical User 

Interface) operating system.
	 2.	 Desktop is where all the icons are 

placed and where different programs 
are run. Desktop consists of icons, 
start button, taskbar, and notification 
area.

	 3.	 The screen saver is an image or an 
animation, which pops up on the 
computer screen whenever a computer 
is left idle means we do not use a 
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keyboard or a mouse for a certain 
period of time.

	 4.	 Desktop icons are the small labelled 
pictures or symbols displayed on the 
desktop that represent a program or a 
file or a folder.

	 5.	 To shut down the system, follow the 
given steps:

		  1. Click on the Start Button.
		  2. Click on the Power Button.
		  3. Select the ShutDown option.
		  4. Sysem will get shutdown.
F.	 1.	 Windows	 2.	 Wallpaper
	 3.	 Desktop	 4.	 OS
	 5.	 Icon	 6.	 Folder

CHAPTER-4
More about Paint

A.	1.	 Paint	 2.	 window
	 3.	 tools	 4.	 Text
	 5.	 Flip
B.	1.	 T	 2.	 T
	 3.	 F	 4.	 T
	 5.	 F
C.	Do your Self.
D.	Do your Self. 
E.	1.	 Flip means rotation of the picture in 

horizontal or vertical direction.
	 2.	 1. In the brushes tool click Air brush.
		  2. Select a spray size.
		  3. Select color to spray.
		  4. �To spray hold down left mouse 

button and drag the mouse pointer 
over the image.

	 3.	 Text tool is used to write text in the 
drawing.

	 4.	 This includes the thickness and style of 
line that is the medium for the shape 
outline like natural pencil, crayon, 
marker, etc. It also fill style that is the 
Color and medium to fill the shape.

CHAPTER-5
More about Word

A.	1.	 Document-1 word	 2.	 NO
	 3.	 1	 4.	 140
	 5.	 100%

B.	1.	 Microsoft	 2.	 Ribbon
	 3.	 MS-Word	 4.	 close
	 5.	 File
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 F
	 5.	 T
D.	Do Your Self.
E.	1.	 Quick access toolbar
	 2.	 Word file-Document1

CHAPTER-6
Introduction to Scratch

A.	1.	 Scratch	 2.	 Sprite
	 3.	 coordinates	 4.	 Blocks
	 5.	 Quit
B.	1.	 T	 2.	 F
	 3.	 T	 4.	 F
	 5.	 T
C.	Blakdrop Icons		  Stage
	 Block Menu	                       Block Palette
D.	1.	 SPRITE
	 2.	 SCRATCH
	 3.	 BLOCK
	 4.	 STAGE
E.	1.	 Scratch is a basic coding language 

that can be used to create animations, 
games, art, etc.

	 2.	 1. Click on the start button and select 
scratch option.

		  2. Scratch Project Window will appear.
	 3.	 Title bar, Menu bar, Cursor tools, 

Stage, Sprite List.
	 4.	 The steps to save any project in scratch 

are as follows :
		  1. Click on the File tab on the menu 

bar.
		  2. Choose save or save as option.
		  3. The save project dialog box appears.
		  4. �Select the location where you want 

to save your project.
		  5. �Type the file name and file type, 

click save button.
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		  6. The project extension will be. sb2.
	 5.	 1. Click on the file menu option and 

select new.
		  2. �A scratch window will appear, we 

can create our new project.
		  3. �Now, click the block (menu) 

categories and drag a block from 
block palette to the script area to 
create a script.

		  4. �Now, run the script by clicking 
block and see changes on the screen.

CHAPTER-7
Introduction to PowerPoint

A.	1.	 (a) Presentation
	 2.	 (a) Home New Slide
	 3.	 (a) Save as
	 4.	 (a) File tab
B.	1.	 slide	 2.	 Microsoft
	 3.	 delete	 4.	 close
	 5.	 slide
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 F
D.	1.	 A presentation is a method of 

communication used to convey 
information, ideas, or a message to an 
audience.

	 2.	 A slide is an individual page of a 
presentation to which we can add 
text, images, sounds and various other 
elements.

	 3.	 The steps to save the presentation are :
		  Step-1 Click on the File tab.
		  Step-2 Click on save option
	 4.	 To create a new blank presentation, 

follow these steps :
		  Step-1 Click on the File tab. This takes 

you to Backstage view.
		  Step-2 Select New.
		  Step-3 Select Blank presentation under 

Available Templates and Themes. It 
will be highlighted by default.

CHAPTER-8
Introduction to Internet

A.	1.	 (a) Internet
	 2.	 (c) Internet Service Provider
	 3.	 (d) All of these
	 4.	 (c) 1969
	 5.	 (c) Client and Server
B.	1.	 Internet	 2.	communication
	 3.	 modem	 4.	Home
	 5.	 Hyperlink
C.	1.	 T	 2.	F
	 3.	 T	 4.	F
	 5.	 T
D.	1.	 c	 2.	e
	 3.	 a	 4.	d
	 5.	 b
E.	1.	 Internet is also called the ‘Net’. It 

is a worldwide system of computer 
network. It remains connected with all 
other networks all over the world, so it 
is also termed as network of networks.

	 2.	 The main purpose of using Internet is 
communication. We can communicate 
on Internet in different forms like 
emails, social media websites, blogs, 
chat and audio-videos.

		  E-commerce refers to buying and 
selling of various products online. It is 
available 24 × 7.

	 3.	 Following are the basic requirements 
to connect the computer with Internet:

		  1. �A telephone or cable line or a dongle 
(Internet data card) for internet 
connection by the Internet Service 
Provider (ISP).

		  2. �A modem to connect the computer 
system with the telephone or cable 
line connection.

		  3. �A software called browser such as 
Chrome/FireFox, etc.

	 4.	 World Wide Web (www) was invented 
in 1989. It was a revolution in the 
world of computing. It is the largest 
information system on Internet. It 
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contains millions of websites that 
provide information in the form of 
text/animations, pictures and videos. 
The World Wibe Web is an example of 
client and server technology.

CHAPTER-9
Artificial Intelligence-Enable 

Devices

A.	1.	 Robot	 2.	 channels
	 3.	 speakers	 4.	 AI
	 5.	 intelligence
B.	1.	 F	 2.	 T
	 3.	 T	 4.	 T
C.	Smart speaker		  Smart watch
D.	1.	 Artificial Intelligence (AI) is the ability 

of machines to display intelligence by 
performing tasks like humans.

	 2.	 A chatbot is used to make an online 
chat conversation with robot. It is very 
common in e-commerce applications 
such as Amazon, Myntra, Flipkart, etc.

	 3.	 A driverless car, also known as an 
autonomous car (AC), self-driving 
car, or robotic car (robo-car), is a 
car that is capable of sensing its 
environment (travelling) without 
human involvement.

	 4.	 Do your self.
	 5.	 A smart doorbell is an AI doorbell 

that can help the owner to get a 
notification on a smart phone at home 
when a visitor arrives. A smart video 
doorbell enables the owner to see/talk 
to the visitor before opening the door. 
It also acts as a security camera.

Test Paper

A.	1.	 b	 2.	 b
	 3.	 c	 4.	 a
	 5.	 c
B.	1.	 Micro computer	2.	hardware
	 3.	 Microsoft	 4.	 Ribbon
	 5.	 Internet
C.	1.	 F	 2.	 F
	 3.	 F	 4.	 T
	 5.	 T
D.	1.	 Window 10 is a GUI (Graphical User 

Interface) operating system.
	 2.	 This includes the thickness and style of 

line that is the medium for the shape 
outline like natural pencil, crayon, 
marker, etc. (Shown in fig.) also fill 
style that is the colour and medium to 
fill the shape.

	 3.	 1. Click on the start button and select 
scartch otpion.

		  2.	 Scartch Project Window will 
appear.

	 4.	 A presentation is a method of 
communication used to convey 
information, ideas, or a massage to an 
audience.

	 5.	 World Wide Web (www) was invented 
in 1989. It was a revolution in the 
world of computing. It is the larget 
information system on Internet. It 
contains millions of websites that 
provide information in the form of 
text/animations, picutres and videos. 
The World Wide Web is an example of 
client and server technology.

F.	 1.	 c	 2.	 e
	 3.	 a	 4.	 d
	 5.	 b
F.	 1.	 Desktop	 2.	 Super computer
	 3.	 Tablet PC

qq
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Computer - 5

CHAPTER-1
Computer System

A.	1.	 (c) System software
	 2.	 (a) Application software
	 3.	 (c) software
	 4.	 (d) All of these
	 5.	 (b) CPU
B.	1.	 Microphone	 2.	 Computer
	 3.	 system	 4.	 patients
	 5.	 Multitasking
C.	1.	 Uninterrupted Power Supply
	 2.	 Input Processing Output
	 3.	 Operating System
	 4.	 Central Processing Unit
D.	1.	 b	 2.	 d
	 3.	 a	 4.	 e
	 5.	 c
E.	1.	 The physical components that you 

can see or touch/feel are known as 
hardware.

	 2.	 The applications and programs that 
help the computer system to perform 
the tasks given by the user are known 
as software.

	 3.	 To perform each different task, a 
computer uses a different program or 
software.

	 4.	 Computer hardware cannot function 
without software.

F.	 1.	 HEALTH	 2.	 LETTERS
	 3.	 TYPES	 4.	 RESEARCH
	 5.	 STORAGE

CHAPTER-2
Computer Memory and  

Storage Devices

A.	1.	 (c) Primary Memory
	 2.	 (d) Secondary Memory
	 3.	 (b) CPU

	 4.	 (c) Dynamic
	 5.	 (d) 1024 KB
B.	1.	 Primary	 2.	 Bit
	 3.	 portable	 4.	 optical
	 5.	 memory
C.	1.	 F	 2.	 T
	 3.	 T	 4.	 T 
	 5.	 T
D.	1.	 Random Access Memory.
	 2.	 Compact Disc-Read Only Memory.
	 3.	 Digital Video Display.
	 4.	 Read Only Memory.
	 5.	 Electrically Erasable Programmable 

Read Only Memory.
E.	1.	 DVD	 2.	 Hard disk
	 3.	 Floppy disk	 4.	 Pen drive
F.	 1.	 RAM (Random Access Memory) : It 

is used by the computer to store data for 
processing. It stores data temporarily. 
As we write new instructions, the 
previous data is erased and new data is 
overwritten.

		  ROM (Read Only Memory) : The 
storage of programs and data in the 
ROM is permanent. It can only be 
read by the CPU but it cannot be 
changed. This memory does not 
erase its contents when the power is 
switched off.

	 2.	 (a) �CD-ROM (Compact Disk-Read 
Only Memory) : The data on these 
CDs can be read only.

		  (b) �CD-R (Compact Disk - 
Recordable) : Data can be written 
by the user once on the CD-R. 
It cannot be deleted or modified 
later.

	 3.	 Pen drive is a portable memory device 
and also called as Flash Drive. It is the 
most popular data backup device. It is 
used for copying and transferring of 
data from one computer to another. It 
can store upto 64GB of data.



14 Computer Answer Key 1 to 8
	 4.	 Primary Memory:
	 (i)	 It is the main memory of the computer. 

It is also called as Internal Memory. 
	 (ii)	The data stored in this memory gets 

erased when the computer is turned 
off.

	 (iii)	The minimum size of primary memory 
is 256 MB.

		  Secondary Memory:
	 (i)	 It is also called as external Memory.
	 (ii)	The data and information are not 

erased even when the computer is 
turned off.

	 (iii)	Internal memory is very limited, so 
external memory play important role 
for storing data and information.

CHAPTER-3
Formatting in MS Word

A.	1.	 look	 2.	 water mark
	 3.	 appearance	 4.	 portrait
	 5.	 Blank
B.	1.	 T	 2.	 T
	 3.	 F	 4.	 F
	 5.	 T
C.	Do your self.
D.	1.	 Formatting text in Microsoft Word 

involves tasks like bolding the text, 
italicising it, and changing the font 
and size.

	 2.	 A font is the specific style of text that 
may include a different font face, point 
size, weight, color, or design. Font 
styles are used in both print and digital 
text.

		  Steps to modify text :
	 (i)	 Select the text that you want to modify.
	 (ii)	Locate the Font group on the Home 

tab.
	 (iii)	Click on the drop-down arrow next 

to font style box and select the desired 
style and font size simultaneously.

	 3.	 Steps to set the margins in document 
are:

	 (i)	� Open the document, the margins 
of which need to be set or select the 

particular part of a document.
	 (ii)	Click the Layout tab—Margins—

Select any predefined margins or 
Custom Margins.

	 4.	 By using shortcuts key Ctrl + B, Ctrl 
+ I, Ctrl + U we can make our text as 
bold, italic or underline.

	 5.	 1. �Select the text you want to modify.
		  2. �Click the Hometab > Locate the 

“font” group.
		  3. �From the lower-right corner of font 

group click the small arrow the font 
dialogbox will appear.

		  4. �Choose the font style and size you 
would like to use.

E.	1.	 Do your self.
F.	 1.	 EDITING	 2.	 PARAGRAPHS
	 3.	 BORDER	 4.	 ALIGNMENT
	 5.	 ARROW

CHAPTER-4
Inserting Objects in MS 

Word
A.	1.	 (b) WordArt	
	 2.	 (c) Insert WordArt
	 3.	 (d) All of these	
	 4.	 (b) Pictures
	 5.	 (d) All of these
B.	1.	 table, picture etc	 2.	Word Art
	 3.	 Insert	 4.	resize
	 5.	 Illustrations
C.	1.	 F	 2.	T
	 3.	 T	 4.	T
	 5.	 T
D.	1.	 The steps to insert the pictures in a 

document are:
		  1. Place the insertion point where you 

want the image to appear.	
		  2. Select the Insert tab on the Ribbon, 

then click on the Pictures command.
		  3. The Insert Picture dialog box will 

appear. Navigate to the folder where 
your image is located, then select 
the image and click Insert.

		  4.	The image will appear in the 
document.

	 2.	 The steps to add word Art in a 
document are:
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		  1. Click on your document where you 

want to add WordArt.
		  2. On the Insert tab, in the Text group, 

click WordArt button. The WordArt 
gallery appears.

		  3.	Click on any WordArt style.
		  4. Word will automatically create a 

text box for text and apply the style 
to the text such as shape style, size in 
format tab, or any other style.

	 3.	 When the shape appears in your 
document, you can begin typing. You 
can then use the formatting options on 
the Home tab to change the font, font 
size, or color of the text. In this way,

	 4.	 Clip art refers to a graphic or picture 
that you can insert in your document. 
It comes in different formats and 
styles.

E.	Do your self.

CHAPTER-5
MS PowerPoint :

Basic & Formatting

A.	1.	 (b) Slide	 2.	(d) All of these
	 3.	 (c) Slide thumbnails	
	 4.	 (c) Theme
B.	1.	 Slideshow	 2.	gradient
	 3.	 Duplicate	 4.	To Do
	 5.	 left, right
C.	1.	 b	 2.	e
	 3.	 c	 4.	a
	 5.	 d
D.	1.	 Quick Access Toolbar: It consists of 

commands that are frequently used 
like Save, Undo, Redo, Print, etc. 

		  Title Bar: Tittle bar displays the name 
of the presentation and three control 
buttons viz, minimize, maximize/
restore and close. 

		  Ribbons: Ribbons different for 
tabs such as Home, Insert, Design, 
Animations, etc. contain commands 
to work with PowerPoint, 

 	 2.	 A blank presentation has no slides 
nor it has any predefined colours or 

styles. It is a plain, black and white 
presentation that can be formatted as 
per your choice. 

	 3.	 Design themes are pre-loaded designs 
(fonts, colors, backgrounds, etc.) 
which can be applied on the slides 
for quick and easy formatting of the 
presentation. This saves a lot of time 
and effort. It also provides a consistent, 
professional look to the presentations.

	 4.	 A blank slide does not have any object. 
To add a text box on the blank slide, 
go to the slide that you want > Insert 
tab > in the Text group > Text Box 
button.

		  Draw the text box, using the mouse 
and type the text in it.

	 5.	 Bullets are used when there is no 
particular sequence of text to be 
followed.

		  Numbers/Alphabet:
		  These are applied to list serialized items 

or steps of a work. To use bullets and 
numbering, first select the text, then 
go to Home tab > Paragraph group 
> Bullets drop-down or Numbering 
drop-down.

D.	 Do your self.

CHAPTER-6
More about Scratch

A.	1.	 (b) Reporter Block
	 2.	 (a) Stack Blocks
	 3.	 (a) They need commands to follow

	 4.	 (a) Script
B.	1.	 Cap	 2.	 Stack
	 3.	 Event Block	 4.	 Hat Block
	 5.	 shapes
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 T
	 5.	 T
D.	1.	 b	 2.	 c
	 3.	 a	 4.	 e
	 5.	 d
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E.	1.	 Scratch is a basic coding language that 

uses ‘building block’ style coding to 
create animated stories, interactive 
games, simulations and beautiful 
artwork.

	 2.	 Block Categories in Scratch are a way 
of organizing blocks in Scratch. Blocks 
are categorized based on what function 
they perform. There are total 10[9 + 
1 (additional block)] categories having 
a specific color. The blocks which 
fall under the same category share a 
common color.

	 3.	 Event blocks are used to manage the 
events which trigger the movement of 
the sprite. These blocks are yellow in 
color and have 9 blocks under them. 
They are 7 Hat blocks and 2 Stack 
blocks. It is the smallest category of 
blocks.

		  Sensing blocks is one of the ten 
categories of Scratch blocks. They are 
color-coded light-blue and are used to 
detect different things.

		  Sensing blocks are used to detect other 
different sprites and objects on the 
stage.

	 4.	 Control Blocks : Control blocks are 
used to control the scripts under some 
specific conditions. These blocks are 
amber in color and have 11 blocks 
under them. Control blocks “control” 
a project and deal with its flow. It 
contains blocks that loop, pause, or 
stop scripts. It also has blocks that deal 
with clones.

E.	Do your self.

CHAPTER-7
Internet Browser and 

Searching
A.	1.	 (d) All of these
	 2.	 (b) Education
	 3.	 (a) Browsing
	 4.	 (a) searching

	 5.	 (a) www.google.com
B.	1.	 Internet	 2.	 Browser
	 3.	 Surfing	 4.	 Enter
	 5.	 WWW
C.	1.	 Internet is a very cheap and easy 

way to get online education. Now-
a-days online lectures and tutorials 
on different subjects or topics easily 
remain available on the Internet and 
we can also download these lectures or 
tutorials into our own computer and 
can listen these lectures repeatedly.

	 2.	 Through video conferencing we can 
talk to each other visually.

	 3.	 Same as D. 1 & 2.
D.	1.	 A brower is a application Software. It is 

used to open websites.
	 2.	 The types of Internet Browser are: 

Skype, Mozilla Firefox, Safari, Google 
Chrome, Internet Explorer, Edge, etc.

	 3.	 A web browser is an application 
websites and the Internet. It retrieves 
information from other parts of the 
web and displays it on your desktopor 
mobile device.

	 4.	 Searching means to find the 
information of any topic on the 
internet. It is an objective and strategy 
based exploration.

E.	Do your self.

CHAPTER-8
Introduction to Artificial 

Intelligence in Smart Homes

A.	1.	 home	 2.	 recognition
	 3.	 visitors	 4.	 Wifi
	 5.	 voice
B.	1.	 T	 2.	 T
	 3.	 T	 4.	 T
	 5.	 F
C.	1.	 Smart car	 2.	 Digital Assistance
	 3.	 E-commerce
D.	1.	 Improves Energy Efficiency.
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	 2.	 Save Resources and Money.
	 3.	 Provides Assurances.
	 4.	 Need reliable internet connection.
	 5.	 Complexity in operating.
	 6.	 Expensive.
E.	Do your self.

Test Paper

A.	1.	 c	 2.	 c
	 3.	 b	 4.	 b
B.	1.	 look	 2.	 Table, picture etc.
	 3.	 gradient	 4.	 cap
	 5.	 Browser
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 T	          5.	 T
D.	1.	 Random Access Memory
	 2.	 Compact Disk-Read only Memory
	 3.	 Digital video Display
	 4.	 Read only Memory
	 5.	 Electrically Erasable Programmable 

Read only Memory
E.	1.	 The steps to insert the pictures in a 

document are:
		  1. Place the insertion point where you 

want the image to appear.	
		  2. Select the Insert tab on the Ribbon, 

then click on the Pictures command.
		  3. The Insert Picture dialog box will 

appear. Navigate to the folder where 
your image is located, then select 
the image and click Insert.

		  4.	The image will appear in the 
document.

	 2.	 Bullets are used when there is no 
particular sequence of text to be 
followed.

		  Numbers/Alphabet:
		  These are applied to list serialized items 

or steps of a work. To use bullets and 
numbering, first select the text, then 
go to Home tab > Paragraph group 
> Bullets drop-down or Numbering 
drop-down.

	 3.	 Control Blocks : Control blocks are 
used to control the scripts under some 
specific conditions. These blocks are 
amber in color and have 11 blocks 
under them. Control blocks “control” 
a project and deal with its flow. It 
contains blocks that loop, pause, or 
stop scripts. It also has blocks that deal 
with clones.

	 4.	 A web browser is an application 
websites and the Internet. It retrieves 
information from other parts of the 
web and displays it on your desktopor 
mobile device.

F.	 1.	 Improves Energy Efficiency.
	 2.	 Save Resources and Money.
	 3.	 Provides Assurances.
	 4.	 Need reliable internet connection.
	 5.	 Complexity in operating.
	 6.	 Expensive.

qq
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Computer-6

CHAPTER-1
HISTORY OF COMPUTERS

A.	1.	 (a)	 2.	 (c)
	 3.	 (c)	 4.	 (c)
	 5.	 (c)	 6.	 (b)
	 7.	 (b)	 8.	 (a)
B.	1.	 Personal Computer
	 2.	 Abacus
	 3.	 Stepped Reckoner
	 4.	 vacuum tubes
	 5.	 Visual Aids
	 6.	 Maps
C.	1.	 T	 2.	 T
	 3.	 F	 4.	 F
	 5.	 T	 6.	 T
D.	1.	 Characteristics of first-generation 

computers are:
	 •	 Vacuum tubes were used in circuits.
	 •	 These computers are very large in size.
	 •	 Programming for this generation was 

done using machine language.
	 •	 They were very expensive and require a  

large amount of electricity.
	 •	 They produce more heat.
	 •	 These computers could calculate data 

in millisecond.
	 •	 The technology used by first-generation 

computers is vacuum tubes.
	 2.	 Minicomputer
	 	 Minicomputers are mid-sized 

computers that fall between 
mainframes and microcomputers.

		  Example: DEC, PDP series.
		  They are different from other types of 

computer as:
	 •	 They are smaller and less powerful 

than mainframes but more robust than 
microcomputers 

	 •	 They are used for tasks that require more 

processing power than microcomputer 
could provide but didn't demand the 
scale and capabilities of mainframes.

	 3.	 Visual Aids: Visual aids are objects, 
images, or other materials that help 
enhance the learning experience 
by providing visual support for 
the information being presented. 
Visual aids play a crucial role in 
making learning more engaging and 
understandable.

	 4.	 There are give generation of computer.
		  1.	First Generation Computers
			   The first generation computers were 

used during 1940-1956. They were 
based on vacuum tbes.

		  2.	Second Generation Computers
			   As transistors developed, it helped 

in generating computers better than 
first generation.

		  3.	Third Generation Computers
			   During the period of 1964 to 1971, 

third generation computers were 
developed.

		  4.	Fourth Generation Computers
			   From 1972 onward the computers 

that we use for daily purposes are 
from the fourth generation.

		  5.	Fifth Generation Computers
			   Fifth generation computers are still 

is development.
	 5.	 1.	Images and Photographs: Displaying 

relevant images and photographs 
helps students visualise concepts, 
people, or places being discussed in 
the lesson.

		  2. Charts and Graphs: Simple charts 
and graphs help in presenting data 
and numerical information in a 
visual format, making it easier for 
students to comprehend.
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E.	1.	 Do your self
	 2.	 Do yourself

CHAPTER-2
ADVANCE MS WORD

A.	1.	 (b)	 2.	 (b)
	 3.	 (c)	 4.	 (a)
	 5.	 (b)	 6.	 (b)
B.	1.	 cell
	 2.	 Merging cell	 3.	 formatting
	 4.	 smaller cells	 5.	 Insert
C.	1.	 T	 2.	 T
	 3.	 T	 4.	 F	          5.	 F
D.	1.	 A table is made up of rows and 

columns. Tables are used to organise  
and represent information. The 
intersection of a row and column is 
called a cell. Each cell can contain text, 
paragraphs, or graphics.

	 2.	To insert table into a word document :
		  1.	 Open Microsoft Word: Launch 

Microsoft Word 2016 and open a 
new or existing document where 
you want to insert the table.

		  2.	 Place Cursor: Click to place 
the cursor in the location of the 
document where you want the table 
to appear.

		  3.	 Insert Table: Navigate to the 
''Insert'' tab on the Word ribbon at 
the top of the window. 

		  4.	 Click on ''Table'': In the "Tables" 
group, you'll see the option to 
Table. Click on it to open the drop-
down menu.

		  5.	 Select the Number of Rows and 
Columns: In the drop-down menu, 
hover over the grid to select the 
number of rows and columns for 
your table. Click on the grid to 
select the desired number of rows 
and columns.

		  6.	 Insert Table: Once you've selected 
the number of rows and columns, 
click on the grid. Word will insert 
the table into your document at 
the location where you placed the 
cursor.

	 3.	 Difference between rows and columns 
in a table is that a column arrange data 
vertically from top to bottom, which 
a raw arranges data horizontally from 
left to right.

	 4.	 Merging cells in a table refers to 
combining two or more adjacent cells 
into a single larger cell. This feature 
is commonly used to create headers 
or titles that span across multiples 
columns in a table. Merging cells in 
MS Word tables helps create a more 
visually appealing layout and allows 
for better organisation of information.

	 5.	 To Insert a new row in an existing 
table:

	 •	 Position the cursor in the table where 
you would like to insert a row. 

	 •	 Select the layout tab under Table 
Tools.

	 •	 Click either the Insert Above or Insert 
Below row buttons Rows & Columns 
Group.

	 6.	 To delete a table in Word document:
		  1.	Selected the table you want to 

delete
		  2.	Access the Table Tools Tab
		  3.	Click the Table Layout or Table 

Tools Layout tab in the Ribbon.
		  4.	Click delete in the Rows and 

columns group. A drop down menu 
appears.

		  5.	Select Delete table.
E.	1.	 Do yourself
	 2.	 Do yourself
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CHAPTER-3
MORE ON MS POWER 

POINT
A.	1.	 (b)	 2.	 (b)
	 3.	 (c)	 4.	 (b)         5.	 (b)

B.	1.	 slides	 2.	 Placeholder

	 3.	 Text	 4.	 Transitions

	 5.	 Entrance

C.	1.	 T	 2.	 F

	 3.	 T	 4.	 T           5.	F

D.	1.	 The purpose of using animations in 
Powerpoint presentations is that it 
helps capture the audience's attention, 
emphasise key points, and make 
presentations more engaging and 
dynamic.

	 2.	 Entrance effects make an object appear. 
Exit effect make an object disappear. 
Emphasis effects draw attention to an 
already-visible object.

	 3.	 Transitions provide a dynamic way to 
move from one slide to the next during 
a slide show. We can add a transition to 
just one slide, different transitions to 
different slides, or the same transition 
to all slides. Power Point makes it easy 
to apply transitions to some or all 
slides, giving presentation a polished, 
professional look.

	 4.	 1. Select the desired slide form the slide 
Navigation pane. This is the slide 
that will appear after the transition.

		  2.	 Click the Transitions tab, then 
locate the Transition to this slide 
group. By default, None is applied 
to each slide.

		  3.	 Click the More drop-down arrow 
to display all transitions.

		  4.	 Click a transition to apply it 
to the selected slide. This will 
automatically preview the 
transition.

	 5.	 1.	 Select the object want to animate.
		  2.	 On the Animations tab, click the 

More drop-down arrow in the 
Animation group.

		  3.	 A drop-down menu of animation 
effects will appear. Select the 
desired effect.

		  4.	 The effect will apply to the object 
will have a small number next to it 
to show that it has an animation. 
In the slide pane, a star symbol also 
will appear next to the slide.

	 6.	 Transition effects are animation 
options with in a presentation. 
Transition effects arte divided into 
three categories: Subtile, Exciting and 
Dynamic content.

		  A slide transition is the visual effect 
that occurs when you move from one 
slide to the next. Transition effects 
can control the speed and sound and 
customize the look.

E.	1.	 Do your self
	 2.	 Do your self
	 3.	 Do your self

CHAPTER-4
MS EXCEL

A.	1.	 (a)	 2.	 (b)
	 3.	 (d)	 4.	 (c)        5.	 (c)
B.	1.	 Spreadsheet	 2.	 A worksheet
	 3.	 workbook	 4.	 Cells
	 5.	 worksheet
C.	1.	 T	 2.	 T
	 3.	 T	 4.	 T	         5.	 F
D.	1.	 A worksheet or sheet is a single page 

in a file created with an electronic 
spreadsheet program such as Microsoft 
Excel or Google Sheets. A workbook 
is the name given to an Excel file that 
contains one or more worksheets. 
When we open an electronic 
spreadsheet program, it loads an 
empty workbook file consisting or one 
or more blank worksheets for us to 
use.
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	 2.	 Ms Excel is a commonly used Microsoft 

office application and it is available for 
windows, mac0S, Android, etc. It is a 
spreadsheet program which is used to 
save and analyse numerical data. In Ms 
Excel, formulas and functions are used 
for calculations, charts are used for 
graphical representation of data.

		  The tasks that we can do in Excel are:
	 •	 Entering tabular data
	 •	 To calculate large data
	 •	 To analyse student performance
	 •	 To interpret data
	 •	 Maintaining student records
	 3.	 Cells are the basic building blocks 

of a worksheet. Each rectangle on 
a worksheet is called a cell. The 
intersection of rows and columns is 
called a cell. A cell is identified by a 
combination of column name and row 
number.

		  The active cell is surrounded by bold 
line border, which is called cell pointer. 
The cell on. of the active cell will be 
displayed in name box. We mostly 
refer to a cell by its cell no. in other 
cells, worksheets, functions, formulas.

	 4.	 1.	Click Start button.
		  2.	 Click Excel 2016.
		  3.	 Select blank workbook.
		  4.	 A blank workbook will appear.
		  5.	 To modify that data of a cell:
			   (a)	 Double-click the cell with the 

text that we want to edit.
			   (b)	 Highlight the text that we want 

to change, or type in the text 
we want to add.

			   (c)	 Press enter to apply the 
changes, or press Escape (ESC) 
to cancel editing.

E.	1.	 Do yourself
	 2.	 Do yourself
	 3.	 Do yourself
	 4.	 Do yourself
	 5.	 Do yourself

F.	 1.	 Do yourself

CHAPTER-5
COMPUTER LANGUAGE

A.	1.	 (b)	 2.	 (c)
	 3.	 (b)	 4.	 (c)         5.	 (c)
B.	1.	 programming
	 2.	 Assembly
	 3.	 Object oriented
	 4.	 binary
	 5.	 Interpreter
C.	1.	 T	 2.	 T
	 3.	 F	 4.	 T          5.	 T
D.	1.	 (c)	 2.	 (a)
	 3.	 (e)	 4.	 (b)         5.	 (d)
E.	1.	 Low level languages are the basic 

computer instruction or better known 
as machine codes. A Computer cannot 
understand any instruction given to 
it by the user in English, Hindi or 
any other high level language. These 
low level languages are very easily 
understandable by the machine. 
This language is to interact with the 
hardware of the computer.

		  It is different from high level language 
as.

		  High level	 Low-level
		  language	 language
	 •	 These are	 •  These are
		  programmer	 machine friendly 
		  friendly languages	 languages
	 •	 They do not	 • They are machine
		  depend on	 dependent and
		  machines	 very difficult.
	 •	 Some examples	 • Some examples
		  are PASCAL, 	 are machine
		  FORTAN, C++, 	 language and 
		  etc	 Assembly 
			   language.
	 2.	 The different generation of 

programming languages are :
	 •	 1st Generation Language
	 •	 2nd Generation Language
	 •	 3rd Generation Language
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	 •	 4th Generation Language
	 •	 5th Generation Language
	 •	 6th Generation Language
		  Over time, programming languages 

have evolved to become more 
expensive, efficient and versatile.

	 3.	 High level languages are programming 
languages. Some prominent examples 
are PASCAL, FORTRAN, C++, etc.

		  The important feature of high level 
languages is that they allow the 
programmer to write programs for all 
types of computers and systems. Every 
instruction in high level language is 
converted to machine language for the 
computer to comprehend.

	 4.	 The characteristics and key features 
of each generation of programming 
languages are:

	 (a)	 1st Generation Language
		  •	 Translation of program is not 

required
		  •	 Program execution is very fast.
		  •	 It is efficient for the computer.
	 (b)	2nd Generation Language
		  •	 It is easy to understand.
		  •	 It requires less no. of instructions.
		  •	 Modification can be done easily.
		  •	 It is memory efficient.
	 (c)	 3rd Generation Language
		  •	 It is machine independent.
		  •	 Debugging is easy.
		  •	 Easy to learn.
		  •	 Less errors with more productivity,
	 (d)	4th Generation Language
		  •	 Development is fast.
		  •	 Easy to maintain.
	 (e)	 5th Generation Language
		  •	 Machines make decisions.
		  •	 Easier to learn and use than other 

languages.
		  •	 It solve problem with less effort.

	 5.	 This is also called as Natural Language. 
The fifth generation programming 
language (5GL) is based on problem-
solving. It uses constraints given to 
the program instead of an algorithm 
written by a programmer. It solves 
problems on its own using artificial 
intelligence or AI technology.

E.	1.	 Do your self

CHAPTER-6
INTRODUCTION TO 

PYTHON
A.	1.	 (c)	 2.	 (a)
	 3.	 (b)	 4.	 (a)        5.	 (b)
B.	1.	 .py	 2.	 lengthy
	 3.	 Values	 4.	 interactive
	 5.	 Title bar
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 T	        5.	 F
D.	1.	 Do your self 
	 2.	 Different working mode of python 

are:
		  Interactive Mode: In this mode, 

the code is executed line by line and 
generate the output. Commands are 
type next to the command prompt. 
Interactive mode produces output that 
is displayed on the screen and then 
disappears. 

		  Script Mode: This mode is used when  
the user is working with more than 
one single code or a block of code.

	 3.	 The use of print ( ) function is used to 
display the output of any command on 
the screen. It can also be used to print 
any message.

	 4.	 For application areas of Python are :
		  (1)	Python can be used to make web-

applications.
		  (2)	Python is also used in the 

development of interactive games.
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		  (3)	Python in used to develop artificial 

applications.
		  (4)	This language is also used for the 

programming of robots.
	 5.	 Variables are used to store data, while 

data types, such as integers, floats, and 
strings, define the nature of the stored 
information.

E.	Do yourself

CHAPTER-7
IMAGE PROCESSING 
BASICS WITH GIMP

A.	1.	 (d)	 2.	 (b)
	 3.	 (a)	 4.	 (a)        5.	 (c) 
B.	1.	 spray paint	 2.	 Ellipse select
	 3.	 Layers	 4.	 scale
	 5.	 Smudge 
C.	1.	 (T)	 2.	 (T)
	 3.	 (T)	 4.	 (T)       5.	 (F)
D.	1.	 GIMP is a freeware and open source 

graphic editing tool. It is an acronym of 
GNU Image Manipulation Program. 
This software is used for image editing 
and retouching, free form drawing, 
converting images into  different 
formats and for more specialised

 	 2.	 (a)	Text tool : It is used to add text on 
the image.

		  (b)	Brush : It allow us to paint.
		  (c)	Pencil : It is used to draw free hand 

lines with a hard edge.
		  (d)	Smudge : It is used to give wet 

paint effect of an image.
		  (e)	Gradient : It is used to fill the 

selection with a colour bend.
	 3.	 Five major parts of GIMP windows 

are:
		  (1)	Menu Bar
		  (2)	Toolbox
		  (3)	Docks or Dialogs Area
		  (4)	Canvas or Image
		  (5)	Status Bar

	 4.	 Three properties of GIMP tool are :
		  Rounded corners: This property sets 

the roundedness of the corners of a 
rectangular selection. 

		  Opacity: This property sets the 
transparency/opacity of the colour. 

		  Feather edges: Selection tools have 
this property to define how much part 
around the selection would be little 
blur.

	 5.	 Filters are special effects that can be 
applied to an image or a selected 
region. Filters enhance the look of the 
image. Filters are organized in several 
categories available as submenus under 
the Filters menu. 

		  To apply a filter: 
		  Select the desired region in the image 

on which filter is to be applied. 
		  Select desired filter from the set of 

submenus under Filters menu. 
E.	Do yourself

CHAPTER-8
INTERNET

A.	1.	 (b)	 2.	 (c)
	 3.	 (a)	 4.	 (b)
B.	1.	 Internet	 2.	 Tim Berners-Lee
	 3.	 Web	 4.	 search engine
	 5.	 symbols
C.	1.	 F	 2.	 T
	 3.	 T	 4.	 T	         5.	 T
D.	1.	 Opera		  2.	Safari
	 3.	 Internet Explorer		 4.	Firefox
	 5.	 Chrome		  6. Edge
E.	1.	 World wide web
	 2.	 Advance Research Project Agency 

Network
	 3.	 Uniform Resource Locator
	 4.	 Department of Defence
F.	 1.	 A search engine is a software system 

that allows Internet users to search 
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for content via the World Wide Web 
(WWW). A user enters keywords or 
key phrases into a search engine and 
receives a list of Web content results in 
the form of websites, images, videos or 
other online data that best match with 
the search query.

		  Some of the search engines are : 
Yahoo!, Google, etc

	 2.	 The Internet is a vast global network 
that connects computers all over 
the world. Through the Internet, 
people can share information and 
communicate from anywhere with an 
Internet connection. It also helps in 
the transfer of messages through mail, 
chat, video & audio conference, etc.

	 3.	 •	 History of Internet—
			   In 1960, the technology began 

when USSR launched it's satellite 
named sputnik.

		  •	 At the end of 19th century, the 
Internet was came into existence 
with the structure of sharing 
messages, information, etc.

		  •	 In 1960, the Internet began as a 
project called ARPANET

		  •	 In 1970, the Internet grew, 
connecting more places. 

		  •	 In 1989, a person named Tim 
Berners-Lee created the World 
Wide Wed (WWW) to make it easy 
for scientists to share information. 

		  •	 In 1990, The Internet became 
available to everyone. Websites, 
email, and services like AOL 
(America Online) became popular.

		  •	 Late 1990's, many new companies 
started online. This was called the 
dot-com boom.

		  •	 In 2000, social media like Facebook 
and Twitter became popular. 

		  •	 In 2007. the iPhone came out, and 

now people could use the Internet 
on their phones. 

		  •	 Today, the Internet is a huge part 
of our lives. 

	 4.	 (a)	A web browser is the software 
installed on your computer or 
mobile that allows you to view 
web pages. On the web, when 
you navigate through pages of 
information, this is commonly 
known as web browsing or web 
surfing.

		  (b)	The world Wide Web (WWW) 
was developed in 1991 by Tim 
Berners-Lee. World Wide Web, is 
also known as a Web, is a collection 
of websites or web pages stored in 
web servers and connected to local 
computers though the Internet. 
These websites contain text pages, 
digital images, audios, videos, etc. 

		  (c)	A website is like a digital place on 
the Internet where you can find 
information, play games, watch 
videos, and do many other things. 
It's like a virtual space where you 
can explore and learn.

		  (d)	A web address, or URL (Uniform 
Resource Locator), is like the 
address of a house on the Internet. 
It tells computer where to find a 
specific website.

CHAPTER-9
ARTIFICIAL INTELLIGENCE

A.	1.	 (b)	 2.	 (b)
	 3.	 (b)	 4.	 (b)
	 5.	 (c)	 6.	 (b)
	 7.	 (c)	 8.	 (b)
	 9.	 (b)	 10.	 (b)
B.	1.	 diseases
	 2.	 AI
	 3.	 The Virtual Tutors
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	 4.	 Technical issues
	 5.	 Radiology
	 6.	 Predictive Maintenance.
	 7.	 Chatbots
	 8.	 help
	 9.	 Privacy and Fairness
	 10.	Sensors
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 F
	 5.	 T	 6.	 T
	 7.	 F	 8.	 F
	 9.	 F	 10.	 F 
D.	1.	 Artificial intelligence refers to computer 

systems capable of performing 
complex tasks that historically only a 
human could do, such as reasoning, 
making decisions or solving Problems.

		  AI is different from traditional 
computer programming as AI is 
about creating algorithms that allow 
computer to learn from data and 
make decisions or predictions, which 
traditional computer programming 
does not.

	 2.	 Artificial Intelligence (AI) has emerged 
as a transformative force in the field 
of healthcare, revolutionising the 
way medical professionals diagnose 
diseases, treat patients, and manage 
healthcare systems. From personalised 
medicine to predicitve analytics, AI is 
reshaping the landscape of healthcare 
delivery in profound ways. 

	 3.	 1.	 Increased Efficiency: AI optimises 
production processes, reducing 
time and costs.

		  2.	 Improved product Quality: AI 
enhances quality through precise 
monitoring and control.

		  3. 	 Enhanced Customer Experience: 
AI personalises shopping 
experiences and improves customer 
service.

		  4.	 Inventory Management: AI ensures 
optimal stock levels, reducing 
overstock and stockouts.

		  5.	 Predictive Analytics: AI forecasts 
demand, helping manufactures 
and retailers plan better.

	 4.	 The role of artificial intelligence 
in education and its potential to 
personalise learning experience for 
students are :

		  1.	 Personalized Learning : AI tailors 
lessons to each student's needs and 
abilities.

		  2.	 Interactive Learning : AI provides 
engaging, interactive learning 
experiences for students.

		  3.	 Efficient Feedback: AI gives instant 
feedback to students, helping them 
improve faster.

		  4.	 Accessibility: AI enables learning 
form anywhere, making education 
more accessible.

		  5.	 Teacher Support: AI assists teachers 
with grading, lesson planing, and 
individualised instruction.

	 5.	 1.	 Initial Investment: Implementing 
AI Technology requires significant 
upfront costs of farmers.

		  2.	 Dependency on Technology: 
Overreliance on AI may reduce 
farmer's traditional farming skills.

		  3.	 Data Security Risks: AI systems 
store sensitive agricultural data, 
raising concerns about privacy and 
security.

		  4.	 Limited Access: Small-scale 
farmers may have limited access 
to AI technology due to cost and 
infrastructure constraints.

		  5.	 Ethical Concerns: AI decision-
making may rise ethical questions 
regarding crop managements and 
biodiversity.

qq
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Computer-7
CHAPTER-1

NUMBER SYSTEM
A.	1.	 (c)	 2.	 (a)
	 3.	 (c)	 4.	 (c)
	 5.	 (d)
B.	1.	 A binary
	 2.	 decimal
	 3.	 Most
	 4.	 numbers
	 5.	 alphanumeric

C.	1.	 F	 2.	 F
	 3.	 F	 4.	 T
	 5.	 T
D.	1.	 A binary number system has only 

two digits that are 0 and 1. The base 
of the binary number system is 2 
because it has only two digits. In any 
binary number, the rightmost digit is 
called the least significant bit (LSB) 
and leftmost digit is called the most 
significant bit (MSB).

	 2.	 Binary Number is : (11000000111001)2

1 1 0 0 0 0 0 0 1 1 1 0 0 1
13 12 11 10 9 8 7 6 5 4 3 2 1 0

1×213 1×212 1×210 1×210 1×29 1×28 1×27 1×26 1×25 1×24 1×23 1×22 1×22 1×20

8192 4092 0 0 0 0 0 0 32 16 8 0 0 1
		  = 8192 + 4096 + 32 + 16 + 8 + 1 = 12345
	 3.		 Advantages and disadvantages of 

Binary Number System :
 		  Advantages : 
	 •	 Data can be stored and sent with 

ease since all potential values are 
represented by two symbols 0 and 1.

	 •	 It is a base which is easily represented 
by electronic devices.

		  Disadvantages :
	 •	 Difficult for most people to read.
	 •	 Takes a lot of digits to represent any 

reasonable number. 
		  Decimal Number System :
 		  Advantages : 
	 •	 Easy readability
	 •	 Used by humans
	 •	 Easy to manipulate
		  Disadvantages : Wastage of space and 

time.
		  Octal Number System :
		  Advantages : It is easy to convert to 

any other number system; because of 
less digits.

		  Disadvantages : Computer does not 
understand the octal numbers in direct 

way, first it has to be converted into 
binary numbers.

		  Hexadecimal Number System:
		  Advantages :
	 •	 They are compact and use less memory.
	 •	 Their small size makes inpout-output 

handling easier.
	 •	 They are also useful to represent 

computer memory addresses.
		  Disadvantages :
	 •	 It can be difficult to perform complex 

mathematical operations.
	 •	 It is also difficult to read and write 

compared to decimal numbers.
	 4.		 Computers perform all of their 

operations using the binary, or base 
2, number system. All program code 
and date are stored and manipulated in 
binary number is known as a bit (for 
binary digit) and can have only one of 
two values, 0 or 1. Bits are commonly 
stored and manipulated in groups of 8 
(known as a byte), 1G (usually known 
as a halfword), 32 (a word), or 64 bits 
(a double word). Sometimes other 
groupings used.

E.	•	 Do your self
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CHAPTER-2
ADVANCE MS WORD

A.	1.	 (a)	 2.	 (b)
	 3.	 (c)	 4.	 (b)
	 5.	 (b)
B.	1.	 multimedia
	 2.	 chart
	 3.	 normal
	 4.	 vertical
	 5.	 Split
	 6.	 Surface
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 T
	 5.	 T	 6.	 T
D.	1.	 A chart is a graphical or pictorial 

representation of data. Charts allow 
users to illustrate numerical data 
such as comparisons etc.. to better 
understand and also predict current 
and future data.

	 2.	 A style is a predefined combination of 
font style, color, and size that can be 
applied to any text in your document. 
Applying a style gives text element a 
specific formatting definition that 
can be consistently applied and 
easily updated. New documents 
automatically use the Normal style.

	 3.	 Step involved in inserting a chart into 
an MS word document are:

	 1.	 Click Insert > Chart.
	 2.	 Click the chart type.
	 3. 	 Select the desired chart, then click ok.
	 4.	 In the spreadsheet that appears, replace 

the default data with own information.
	 5.	 Enter source data into the spreadsheet.
	 6.	 When finished, close the spreadsheet.
	 7.	 The chart will be completed.
	 8.	 If want, use the Layout Options 

button to arrange the chart and text in 
document.

		  The use of different type of charts 
are:

		  Column Charts:
		  A column chart is represented in 

vertical columns means vertical bars 

are used to represent date. The column 
height of each category is proportical 
to the values plotted. 

		  Line Chart:
		  It is a chart that shows a line joining 

several points or a line that shows 
the relation between the points. It is 
commonly drawn to show information 
that changes over time.

		  Pie Chart:
		  Pie chart is a circular representation of 

data. It is called a pie chart because the 
sectors of the circles are just slices of a 
pie. The area within each sector (slice) 
represents the size of the data.

		  Bar Chart 
		  Bar charts are similar to column charts 

and both display data in rectangular 
bars. But a bar chart plots the variable  
value horizontally, and the fixed 
dimension  vertically. 

		  Area Chart

		  Area charts are just like line charts, 
except the areas under the lines are 
filled in.

		  Surface Chart

		  Surface chart is actually a 3D chart 
that helps to represent the data into 
a 3D landscape. These charts are best 
to use with a large dataset. This chart 
allows to displaying a variety off data 
at the same time.

	 4.	 A table style holds a set of table, row, 
cell, paragraph and text formatting that 
can be applied to tables. Using table 
styles instead of directly formatting a 
table saves time in modifying the look 
of a table and switching to a different 
table style.

	 5. 	 To add data to a chart in MS word :

		  (i) 	Click Insert > Chart
		  (ii) Click the chart type and then 

double click the chart you want.
		  (iii) In the spreadsheet that appears. 
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replace the default data with your own 
information.

		  (iv) When you're finished, close the 
spreadsheet.

E.	1.	 Do your self
	 2.	 Do your self
	 3.	 Do your self
	 4.	 Do your self

CHAPTER-3
ADVANCE POWER POINT

A.	1.	 (a)	 2.	 (b)
	 3.	 (b)	 4.	 (a)
	 5.	 (c)	
B.	1.	 theme
	 2.	 taskbar
	 3.	 shape
	 4.	 Mouse
	 5.	 ESC
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 T
	 5.	 T
D.	1.	 Steps to add an audio to a 

presentation
	 1.	 Click on Insert tab and look for media 

group.
	 2.	 Click on audio option and choose 

Audio on My PC option from the list 
that appears.

	 3.	 Insert Audio dialog box appears.
	 4.	 Choose the required audio file and 

click the insert button.
	 5.	 Selected audio will be added to the 

side.
		  Steps to add a video to a presentation
	 1.	 Click on Insert tab and look for media 

group.
	 2.	 Click on video option and choose 

video on My PC option from the list 
that appears.

	 3.	 Insert video dialog box appears.
	 4.	 Choose the required video file and 

click the insert button.
	 5.	 Selected video will be added to the 

slide.

	 2.	 Presenter view gives access to a special 
set of controls on screen that the 
audience won't see, allowing presenter 
to easily reference slide notes, preview 
the upcoming slide, and much more.

	 3.	 A theme is a predefined combination 
of fonts, colors and effects. Different 
themes also use different slide layouts. 
The defaults theme is MS office theme. 
It help in creating presentation by 
giving entire presentation a consistent 
professional look.

	 4.	 To access slide show setup options:
	 1.	 Select the Slide Show tab, then click 

the Set Up Slide Show command. 
	 2.	 The Set Up show dialog box will 

appear. Form here, we can select the 
desired options for our presentation.

		  Click the buttons in the setup show 
dialog box below to learn about various 
options for setting up and playing a 
slide show.

		  To advance slides automatically, we'll 
need to customize the slide timing on 
the Transitions tab.

	 5.	 Slide Sorter view display all the slide in 
presentation in horizontally sequence 
or in thumbnail form. This make it 
useful in organising and arranging 
slides, just by dragging and dropping 
them wherever we want. 

E.	1.	 Do your self

CHAPTER-4
MORE ON MS EXCEL

A.	1.	 (b)	 2.	 (b)

	 3.	 (c)	

B.	1.	 Three

	 2.	 Save

	 3.	 cell

	 4.	 Text

	 5.	 Delete
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C.	1.	 T	 2.	 T
	 3.	 F	 4.	 F
	 5.	 F
D.	 Steps are as follows:
	 1.	 Click the file tab and select Save As 

option.
	 2.	 Select a location where you would 

like to save the sheet, Enter file name, 
which you want to give to your sheet 
and select a Save as type, by default it 
is. xlsx format.

	 3.	 Click on Save button and sheet will be 
saved.

		  Saving work regularly is important as 
in case the computer frezes, crashes 
or restarts, then unsaved work will be 
lost. 

	 2.	 Click the File tab > New > Blank 
Workbook icon

		  A new blank workbook will appear.
	 3.	 You can edit the contents of a cell 

directly in the cell you can also edit 
the contents of a cell by typing in the 
formula bar.

		  When you edit the contents of a cell, 
Excel is operating in edit mode. Some 
excel features work differently or are 
unavailable in edit  mode.

		  When Excel is in edit mode the word 
edit appears in the lower - left corner 
of the excel program window.

	 4.	 Cut : Cutting in Excel, cut or remove 
a file from one folder and pasting it to 
another.		  Copy : 
Copying in Excel simply copies the 
data or formula from one cell to 
another, leaving the original data in 
the original cell.

		  To use Copy and Paste:
	 1.	 Select the cell as we have selected B9:
	 2.	 Click the Copy command on the 

Home tab, or press ctrl+C on keyboard.
	 3.	 Select the cell where you want to paste 

the copied data. We have selected D8 
to D13.

	 4.	 Click the Paste command on the Home 
tab, or press Ctrl+V on keyboard.

	 5.	 The content will be pasted into the 
selected cells. 

		  To use Cut and Paste:
	 1.	 Select the cell as we have selected 

D8:D13
	 2.	 Right-click the mouse and choose the 

Cut command or, you can use the 
command on the Home tab, or press 
Ctrl+X on Keyboard.

	 3.	 Select the cells where you want to paste 
the content. We have pasted content 
to F8: F13 and the cut content will be 
removed from D8:D13.

	 5.	 To open a workbook in excel :
	 1.	 Click the File tab and choose Open.
	 2.	 The Open dialog box appears.
	 3.	 Browse the directory and find the file 

you need to open.
	 4.	 Click the file you want to open and 

then click the Open button, or double 
- click the file's icon.

E.	1.	 Do your self
CHAPTER-5

PROGRAMMING IN 
PYTHON

A.	1.	 (c)	 2.	 (a)
	 3.	 (c)	 4.	 (b)
	 5.	 (b)
B.	1.	 reserved
	 2.	 variable
	 3.	 three
	 4.	 Float
	 5.	 string
C.	1.	 F	 2.	 T
	 3.	 T	 4.	 F
	 5.	 T
D.	1.	 A variable is a container for a value. It 

can be assigned a name, you can use it 
to refer to it later in the program.

	 2.	 The python type ( ) function print 
what type of data structures are used to 
store the data elements in a program.

	 3.	 Global variable:- Global variable in 
python are those which are not defined 
inside any function and have a global 
scope. This variable are accessible 
throughout the program and inside 
every function.
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		  Local Variables: Local variables in 

python are those which are initialized 
inside a function and belong only to 
that particular function. It cannot 
be accessed anywhere outside the 
function.

	 4.	 Various naming rules for Python 
Variables are:

	 •	 A variable name must start with a 
letter or the underscore character.

	 •	 A variable name cannot start with a 
number.

	 •	 A variable name can only contain 
alpah-numeric characters and 
underscores (A-z, 0-9, and –).

	 •	 Variable names are case-sensitive 
(age, Age and AGE are three different 
variables).

	 •	 A variable name cannot be any of the 
Python keywords.

	 5.	 We can display a character from a 
string using its index in the string. 
Remember, indexing starts with 0.

		  >>> doctor='appointment'
		  >>> doctor [0]
		  Output
		  'a'
		  We  can also display a substring from a 

string using the slicing operator [].
		  >>> doctor [2:7]
		  Output
		  'point'
		  This prints the characters from 2 to 6.
E.	1.	 Do your self

CHAPTER-6
MORE ON PYTHON

EXERCISE
A.	1.	 (b)	 2.	 (c)
	 3.	 (a)	 4.	 (a)
	 5.	 (c)
B.	1.	 keyboard
	 2.	 string
	 3.	 \n
	 4.	 conditional
	 5.	 Print ( )

C.	1.	 T	 2.	 F
	 3.	 T	 4.	 T
	 5.	 F
D.	1.	 For Loop: For loop execute a block of 

code, a fixed number of times. You can 
iterate over a range, string, sequence 
etc.

	 2.	 The types of loops in python are:
	 •	 For Loop
	 •	 While loop
	 3.	 Python if...elif...else Statement
		  A user can choose from a variety 

of alternatives here. In this variant 
of 'if statement', there are many 
else if conditions declared. If the 
condition does not satisfy then the 
next condition is executed. But if this 
condition also does not satisfy then the 
next condition is executed. Let us look 
at the syntax and the flowchart of if...
elif... else statement.

	 4.	 Python Functions

		  A Python Function is a block of code 
which only runs when it is called and 
performs a specific task. 

		  We can pass data, known as parameters, 
into a function. 	A function can return 
value (data) as a result.

		  For Example:
		  def fun( ):
		       print ('Hello')
		  Here def is keyword used to create 

a function. fun( ) is the name of 
function.

		  Print('Hello') is the body of function.
	 5.	 We return a value from the function 

using the return statement.
	 Example: Finding cube of a number using 

return statement.
	 1.  	Cube of a number 27
	 2.	 det Find cube(run)
	 3.	 Result = run = run = run
	 4.	 Return result
	 5.	
	 6.	 = calling function
	 7.	 cube = Find - cube (3)
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	 8.	
	 9.	 Print ('cube of number, code)
	 In the above example, we have created a 

function named find–cube(). The function 
accepts a number and returns the cube of 
the number.

E.	1.	 Do your self
CHAPTER-7

INTRODUCTION TO HTML
EXERCISE
A.	1.	 (b)	 2.	 (b)
	 3.	 (a)	 4.	 (c)
	 5.	 (b)
B.	1.	 text
	 2.	 Server
	 3.	 Web browser
	 4.	 document
	 5.	 Web pages
C.	1.	 T	 2.	 T
	 3.	 T	 4.	 F
	 5.	 T
D.	1.	 HTML is Hypertext Markup 

Language. It is used to create web 
pages.

	 2.	 (1) HTML documents are simple text 
files.

		  (2) Compiling is not required in 
HTML.

	 3.	 Step 1 : Open Notepad.
		               Type the HTML code.
		  Step 2 : Click on the File menu to 

save. Save as dialogue box will appear.
		  Step 3 : Make the choice of the folder, 

where file is to be saved and type a file 
name followed by extension. htm or 
.html.

		  Step 4 : Click on Save button.
	 4.	 To create, use text editor.
		  To view, use web browser.
	 5.	 Web browser is used to view and 

display the HTML documents.
E.	1.	 Do your self

CHAPTER-8
INTRODUCTION TO FLASH

EXERCISE
A.	1.	 (b)	 2.	 (b)
	 3.	 (d)	 4.	 (d)
B.	1.	 width	 2.	 name
	 3.	 commands	 4.	 Pencil tool
	 5.	 two
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 F
	 5.	 T
D.	1.	 (1) Title Bar : It shows name of the 

currently open file.
	 (2)	Stage : It shows work done.
	 (3)	Menu Bar : It carries all commands, in 

flash.
	 (4)	Color Palette : It has a variety of 

colours.
	 (5)	Work Area : It is the place on both 

sides of the stage.
	 (6)	Timeline Panel : It controls the 

organised file content overtime in layer 
and frames.

	 (7)	Tools Panel : It contain different tools 
to choose from.

	 (8)	Property Inspector: It can organise 
and modify the properties of current 
selection.

	 2.	 Brush tool enables the user to draw 
thick strokes of line.

	 3.	 Color Palette has a variety of colors to 
work with.

	 4.	 Four ways in which free transform tool 
works are :

		  1. Distort
		  2. Scale
		  3. Rotate and skew
		  4. Envelop
	 5.	 Text Tool enables the user to add text 

working.
		  Steps to add text :
		  Step 1 : Click on Text tool.
		  Step 2 : Adjust the text color, font and 

font size.
		  Step 3 : Types the text.
E.	1.	 Do your self
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LESSON - 9

MORE ON INTERNET
EXERCISE
A.	1.	 (b)	 2.	 (d)
	  3.  (b)	 4. 	 (a)	            
     5.  (c)
B.	 1. Cyber security
	 2.	 browser
     3.	 phrases
	 4.	 teacher, students and parents
     5.	 Country
	 6.	 country
C. 1. (T)	 2.(T)   
     3. (T)	 4. (F)
     5. (F)	 6. (T)
     7. (T)	 8. (T) 
     9.(F)	 10.(T)
D. 1. A search engine is like a big library 

where we can look for information on 
almost any topic. It is a website that 
helps us to find other websites, articles, 
pictures , and videos.

		  When we want to find something 
online, we type a word or phrase related 
to our topic into the search bar of a 
search engine, like Google or Bing. 	
The search engine then looks through 
its vast collection of information, 
which is called an index, to find web 
pages that match our search words.

	 2.	 Three popular web search engines are:
		  Google, Bing, Yahoo!
		  Google : It allows Android users to 

search anything on their screen by 
simply circling or highlighting it.

		  Bing : It affers higher-quality images 
with more detailed information.

		  Yahoo! : It allows to see what we've 
searched for in the past.

	 3.	 DIKSHA stands for Digital 
Infrastructure for Knowledge Sharing. 
The Diksha portal is an online platform 
developed by the Indian government 
to provide digital educational resources 
and tools to teachers, students, and 

parents across the country. The Diksha 
portal is like a magical treasure trove 
of educational resources that students 
and teachers can explore to make 
learning and teaching more enjoyable 
and effective. It's wonderful tool to 
help everyone in their educational 
journey!

	 4.	 Swayam, stands for Study Webs of 
Active Learning for Young Aspiring 
Minds, is an online platform 
introduced by the Government of 
India to offer free online courses to 
learners across the country. Swayam 
is like a digital treasure trove of 
educational opportunities that 
students and learners of all ages can 
explore to discover new interests 
and enhance their understanding of 
various subjects. It's a fantastic tool to 
support lifelong learning and personal 
growth!

	 5. " PM e- Vidya" is an initiative launched 
by the Government of India to provide 
digital education and online learning 
resources to students across the 
country. PM e- Vidya is like a digital 
classroom that brings education to our 
fingertips. It's a wonderful tool to help 
students learn, explore, and grow, even 
when they can't be physically present 
in a traditional classroom setting.

	 6.	 Cybersecurity is like a shield 
that protects our devices, such as 
computers, tablets, and smartphones, 
from bad things on the internet.

		  It is important as it helps to keep our 
online information safe from hackers 
and bad people who might want to 
steal it or do harm.

E.	Do yourself

LESSON - 10
CLASSIFICATION OF AI

A.	1. (a)	 2.(b)
	 3. (c)	 4.(a)
	 5. (a)	
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B.	1. Super AI
	 2.personalized
	 3.real- time
	 4.security
	 5.learning
	 6.accurately and quickly
C. 1.(T)	 2.(F)
	 3.(T)	 4.(T)
	 5.(F)
D. 1.	 Narrow AI, also know as weak AI,refers 

to AI systems that sre designed and 
trained for a specific task or set of tasks. 
These systems excel in performing a 
narrow range of tasks within a well- 
defined domain.

		  An example of Narrow AI that we 
use in our daily life include virtual 
personal assistants like Siri or Alexa.

	 2.	 General AI, also know as Strong AI or 
Artificial General Intelligence (AGI), 
refers to AI systems that have the 
ability to understand learn, and apply 
knowledge across a wide range of tasks 
and domains.

		  These systems would exhibit human-
like intelligence and cognitive abilities, 

including reasoning, problem - 
solving, creativity, and emotional 
understanding.

		  Unlike Narrow AI, General AI would 
be capable of learning new tasks 
and adapting to new environments 
without the need for reprogramming 
or significant human intervention.

	 3.	 Superintelligence refers to a 
hypothetical level of intelligence that 
surpasses the cognitive capabilities 
of humans across all domains and 
activities.

		  Unlike Narrow AI and General AI, 
Super AI surpasses human intelligence, 
performing any task better than 
humans.

	 4.	 Virtual personal assistants like Siri, 
Alexa and Google Assistant use AI 
to understand natural language 
commands and perform tasks such as 
setting reminders, sending messages, 
and answering questions. They 
make daily life more convenient and 
efficient.

E.	Do your self
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Computer-8
CHAPTER-1

NUMBER SYSTEM
A.	1.	 (b)	 2.	 (a)
	 3.	 (a)	 4.	 (b)
	 5.	 (c)
B.	1.	 Octal	 2.	 10
	 3.	 0	 4.	 16
	 5.	 Bits
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 F
	 5.	 T
D.	1.	 Divide the number by 2 till we get 1 

as the quotient. Then starting from 
the last remainder write all the from 
left to right get the binary equivalent 
number. 

	 2.	 Number system is a system of 
reprocessing number in various ways. 
It denotes group of character which 
denote various numerical quantities. 
There are various kinds of number 
system e.g., Decimal, Hexadecimal, 
Octal and Binary number systems.

	 3.	 2	 69	 Remainder 1
		  2	 34	 Remainder 0
		  2	 17	 Remainder 1
		  2	 8	 Remainder 0
		  2	 4	 Remainder 0
		  2	 2	 Remainder 0
			   01	 Remainder 1
		  (69)10 = (1000101)2
	 4.	  10101
	           1101
		  100010
	 5.	 (1111)2 and (1001)2

	  	              1111
		             ×1001
                       1111
                     0000×
	                0000××
	              1111×××
                10000111			 
E.	•	 Do your self

CHAPTER-2
MS EXCEL: FUNCTIONS 

AND FORMULAS
A.	1.	 (a)	 2.	 (a)
	 3.	 (a)	 4.	 (a)         5.	 (d)
B.	1.	 Windows	 2.	 Worksheets
	 3.	 Clear contents	4.	 Insert > Comments
	 5.	 Auto sum.
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 T	         5.	 T
D.	1.	 Five formatting tools available on 

Home tab in Excel are :
		  a. Font name b. Font size c. Alignment 
		  d. Wrap text e. Merge & Center
	 2.	 A formula is an equation that performs 

a calculation. Like a calculator, Excel 
can execute formulas for addition, 
subtraction, multiplication and 
division.

	 3.	 Type an equal sign (=) and then type 
a function for example = SUM for 
getting the total sales. Type an opening 
parenthesis (select the range of cells, 
and then type a closing parenthesis).

	 4.	 The steps to apply a colourful border 
to a cell in a worksheet is

		  a.	 Click on Border tab.
		  b.	Click on the drop-down arrow and 

select the desired colour.
		  c.	 Click on ok button.
	 5.	 The Alignment tab is where you place 

text and numbers in cells, modify 
their orientation and specify the text 
control.

 	 6.	 To perfrom basic mathematical 
operations, arithmetic operators 
are used. For example, + (Plus sign) 
for addition, – (Minus sign) for 
subtraction, * (asterisk sign) for 
multiplication, / (forward slash) for 
division, % (Percentage sign) for 
percentage and (^) carat for exponents.
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	 7.	 Formatting text or number can make 

them appear more visible  especially 
when you have a large worksheet. 
Changing default formats includes 
things like changing the font colour, 
style, size, text alignment in a cell, or 
apply formatting effects.

E.	1.	 An equal sign is must to be at the start 
of each formula.

	 2.	 Rahul used plus (+) sign to perfrom 
addition on the computer.

	 3.	 Rahul used multiplication (*) sign 
to perform multiplication on the 
computer.

CHAPTER-3
MS EXCEL: USING CHARTS 

TO PRESENT DATA
A.	1.	 (b)	 2.	 (b)
	 3.	 (d)	 4.	 (a)        5.	 (b)
B.	1.	 F11	 2.	 Items
	 3.	 Tools	 4.	 Interconnected
C.	1.	 T	 2.	 F
	 3.	 T	 4.	 F	          5.	 T
D.	1.	 A chart is a tool that  can use in Excel 

to represent data pictorially. Charts 
allow audience to see the meaning 
behind the numbers, and they make 
representing comparisons and trends 
much easier.

	 2.	 Various types of charts that can be 
created in MS Excel are :

		  Column Chart
		  The information is shown in vertical 

columns in this chart. It typically 
displays categories along the horizontal 
axis and values along the vertical axis. 
It allows you to compare two or more 
items in a single category of data.

		  Line Chart
		  A line graph (line chart or run chart), 

in this chart, data is plotted in the 
from of line with connecting dots. It 
displays categories along the horizontal 
axis and values along the vertical axis.

	 	 Pie Chart
		  In this chart, data is displayed in the 

form of circles that shows this size of 
items in one data series, proportional 
to the sum of the items.

	 	 Bar Chart
		  In this chart, data is displayed in the 

form of horizontal bars. It displays 
categories along the vertical axis and 
values along the horizontal axis.

		  Area Chart
		  An area chart is a primary Excel 

chart type, with data series plotted 
using lines with a filled area below. 
Area Charts are a good way to show 
magnitude of change over time. 

		  Funnel Chart
		  A funnel chart is a visual representation 

of progress across certain stages. This 
chart should have at least 3 stages to 
show.

	 3.	 Steps to move a chart on the worksheet:
		  a. The mouse pointer transforms into 

a moving handle when you point it 
anywhere on the chart.

		  b. Click and drag the chart to new 
location.

	 4.	 To change the chart style in a worksheet
		  a. Select the chart on the worksheet. 

The chart tools (having Design and 
Format tabs) appear on Ribbon.

		  b. Click on Design tab.
		  c. Select the desired style from the 

menu by clicking the chart style drop-
down button.

	 5.	 To move a chart on the worksheet:
		  a. The mouse pointer transforms into 

a moving handle when you point it 
anywhere on the chart.

		  b. Click and drag the chart to new 
location.

	 •	 To resize a chart on the worksheet:
		  Put mouse cursor on the corner of the 

chart and drag it diagonally.
	 •	 To print out the chart:
		  Select the chart and press Ctrl+P.
	 6.	 The Steps to insert a picture in the 

worksheet are:
		  a. Select any cell.
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		  b. Click the Pictures tool in the 

Illustrations group on the Insert Tab. 
The dialog window for inserting a 
picture appears. 

		  c. Locate the required image and select 
it.

		  d. click on Insert button.
		  The selected image is inserted in the 

worksheet.
E.	1.	 By using Column Chart
	 2.	 By using Pie Chart
	 3.	 By using Bar chart

CHAPTER-4
CLOUD COMPUTING

A.	1.	 (a)	 2.	 (d)
	 3.	 (c)	 4.	 (a)         5.	 (c)
B.	1.	 Private	 2.	 IaaS, PaaS, SaaS
	 3.	 Paas
	 4.	 Google online storage
	 5.	 Trash
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 F	           5.	T
D.	1.	 Cloud computing is the delivery of 

computing services such as servers, 
storage, databases, networking, 
software, Analytics, intelligence, and 
more, over the Cloud (Internet).

	 2.	 If we choose cloud computing, a cloud 
vendor is responsible for the hardware 
purchase and maintenance. They also 
provide a wide variety of software and 
platform as a service. We can take any 
required services on rent. The cloud 
computing services will be charged 
based on usage.

	 3.	 This service provides an on-demand 
environment for developing, testing, 
delivering, and managing software 
applications. The developer is 
responsible for the application, and 
the PaaS vendor provides the ability 
to deploy and run it. Using Paas, 
the flexibility gets reduce, but the 
management of the environment is 
taken care of by the cloud vendors.

	 4.	 Google Drive is cloud storage 
developed by Google. We can store 
our files online in Google Drive and 
can access them from anywhere in the 
whole world. Drive gives 15 GB of 
free Google online storage. in which 
we can keep files, folder, backups and 
everything that is important.  

E.	1. 	 Opening Google Drive
		  To start Google Drives, open Google 	

	 page in the web browser.
		  1.	 In the Google page, click on 

Signin.  Google account page will 
appear. 

			   You login ID and password are 
same  as that of your Gmail 
account.

		  2.	 Type your login ID and the 
password. Password will appear in 
the form of  black dots.

		  3.	 Click on Next button. Google 
page appears again with your login 
details.

		  4.	 Click on Google Apps button. A 
list of all Google Apps Appears.

		  5.	 Click on Google Drive. Google 
Drive window appears.

	 2.	 To Rename the document
		  1. Click on File menu.
		  2. Click on Raname.
		  3. Type the name, you desire in the 

box.
		  4. Press the enter key.
		  The new name will appear in Docs App. 

CHAPTER-5
COMPUTER VIRUS AND ITS 

DETECTION
A.	1.	 (b)	 2.	 (c)
	 3.	 (c)	 4.	 (c)        5.	 (a)
B.	1.	 Bombs	 2.	 AVG
	 3.	 data	 4.	 speed
	 5.	 Pen drive
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 F 	          5.	T
D.	1.	 Computer virus can harm by modify 

or corrupt files, delete data, steal 
passwords etc.
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		  Some of the routes from which a virus 

can attack a computer are:
		  (i) E-mail.
		  (ii) Infected pen drive & CDs.
		  (iii) Downloading infected files.
		  (iv) Starting an infected application.
	 2.	 Types of computer viruses and their 

effect:
		  (1) Bombs: damage the computer.
		  (2) Boot Sector Virus: damage the 

boot sector  part of  floppy disk.
		  (3) Trojans: destroy data.
		  (4) Worms: spread everywhere and 

affect the speed.
	 3.	 Programs which are used to detect and 

remove viruses.
	 4.	 Norton, AVG, Avast, Kaspersky.
	 5.	 Keyboard & mouse.
E.	(1)	Do your self

CHAPTER-6
COMPUTER ETHICS, 

CRIMEAND SECURITY

A.	1.	 (a)	 2.	 (c)
	 3.	 (c)	 4.	 (b)         5.	 (a)
B.	1.	 illegal	 2.	 Software
	 3.	 copyright	 4.	 warranty
	 5.	 Hardware
C.	1.	 F	 2.	 T
	 3.	 F	 4.	 F          5.	 T
D.	1.	 Software piracy or copyright violation 

refers to the illegal copying and 
distribution of commercial copyright 
without paying for it.

	 2.	 Hacker is person, who breaks into 
computer system to get invalid 
exposure to confidential data and 
information.

	 3.	 Online auction piracy refers to sale of 
a software that is not authorized for 
resale.

	 4.	 Pre-installed software piracy refers 
to invalid installation of a computer 
software on multiple systems by the 
manufacturer.

	 5.	 Cracker is person, who breaks into 
computer system to use passwords, 
files or programs illegally.

E.	Do yourself

CHAPTER-7
BROWSING INTERNET

A.	1.	 (b)	 2.	 (b)
	 3.	 (b)	 4.	 (a)         5.	 (a)
B.	1.	 Contacts	 2.	 acronyms
	 3.	 uppercase	 4.	 E-mail
	 5.	 Copyright
C.	1.	 T	 2.	 F
	 3.	 F	 4.	 T          5.	 T
D.	1.	 Intention to hurt or embarrass other 

persons by sending or posting wrong 
text or images through the internet, is 
known as cyber bullying.

	 2.	 A combination of keystrokes that form 
a sort of picture related to an emotion 
is called emoticon.

	 3.	 Short forms of words used to 
communicate on Internet are known 
as acronyms.

	 4.	 Internet provides an easy way to get 
information from all over the world. 
It provides many facilities like sending 
and receiving messages, greeting cards, 
downloading music, songs or pictures 
and many more.

	 5.	 E-mail address is used to send or 
receive messages.

E.	•	 Do your self

CHAPTER-8
ARTIFICIAL INTELLIGENCE: 

INTRODUCTION
A.	1.	 (d)	 2.	 (d)
	 3.	 (d)	 4.	 (b)        5.	 (d)
B.	1.	 Interpreting
	 2.	 artificial intelligence
	 3.	 fourth industrial revolution
	 4.	 John Mc Carthy
C.	1.	 T	 2.	 T
	 3.	 F	 4.	 T	         5.	 T
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D.	1.	 (a) Human Intelligence:
		  Human intelligence is a mental 

attribute that includes the capacity to 
learn from experience, adapt to new 
conditions, comprehend and handle 
abstract concepts, and manipulate 
one's surroundings using knowledge.

		  (b) Artificial Intelligence
		  Artificial intelligence refers to the 

simulation of human intelligence in 
machines that are programmed to 
third like humans and mimic their 
actions

	 2.	 The phrase "Artificial Intelligence" 
was coined by John McCarthy (1927-
2011), an American Computer 
scientist and cognitive scientist. He 
was a pioneer in the field of artificial 
intelligence. Along With Alan Turing. 
Marvin Minsky, Allen Newell, and 
Herbert Simon, John McCarthy is 
considered one of the "founding 
fathers" of artificial intelligence.

	 3.	 Artificial intelligence (AI) refers to 
a machine's ability to do cognitive 
functions such as thinking, perceiving, 
learning. Problem-solving, and making 
decisions. Originally envisioned 
as a device capable of imitating 
human intelligence. With amazing 
advancements in data gathering, 
processing, and computation power, 
intelligent systems may now be 
deployed to take over a range of jobs, 
enable communication, and boost 
productivity.

	 4.	 Al isn't a well-defined technology, 
and there isn't a single description 
that everyone agrees on. It's more 
of a catch-all word for data analysis 
and pattern detection tools. Artificial 
Intelligence (AI) is a technology that 
has been around since the 1950s. 
Some markets, industries, and 
businesses are further advanced than 
others, because AI is still in its early 
stages of development. There are 

many opportunities for additional 
development and enhancement in 
terms of both the range of possible 
applications and the quality of most 
existing implementations.

	 5.	 Artificial intelligence (AI) is the future 
of all complicated decision-making 
and is the foundation for all computer 
learning. AI is the attempt to make 
computers think and act like humans.

E.	1.	 John McCarthy
	 2.	 Artificial Intelligence.
	 3.	 AI refers to the simulation of human 

Intelligence in machines that are 
programmed to think like humans and 
mimic their actions.

CHAPTER-9
Future of AI and Rise of 

New Technology
A.	1.	 (b)	 2.	 (a)
	 3.	 (a)	 4.	 (a)         5.	 (a)
B.	1.	 virtual mannequin
	 2.	 Journalists	 3.	 AR / VR
	 4.	 virtual reality
	 5.	 Augmented reality
C.	1.	 F	 2.	 T

	 3.	 T	 4.	 T	          5.	T
D.	1.	 The term Artificial Intelligence was 

initially coined by John McCarthy in 
1955, which meant a machine that can 
solve problems that humans perform-
using natural intelligence.

	 2.	 Augmented reality (AR) is an 
enhanced version of the real physical 
world that is achieved through the 
use of digital visual elements, sound, 
or other sensory stimuli delivered via 
technology. It is the integration of 
digital information with the user's 
environment in real time.

	 3.	 Three examples of AR technology are :
		  (a) Pokemon Go
		  (b) Snapchat
		  (c) Google Maps
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	 4.	 Difference between Augmented 

Reality and Virtual Reality:
		  l	 AR uses a real-world setting while 

VR is completely virtual.
		  l	 AR users can control their presence 

in the real world; VR users are 
controlled by the system.

		  l	 AR can be accessed with a 
smartphone while VR requires a 
headset device.

		  l	 AR enhances both the virtual and 
real world while VR only enhances 
a fictional reality.

		  l	 Google Glass is an AR device while 
Oculus Rift is a VR system.

	 5.	 AI applications in healthcare can 
literally change patients' lives, 
improving diagnostics and treatment 
and helping patients and the 
healthcare provider make informed 
medical decisions quickly. Diseases are 
diagnosed more quickly and accurately 
in the relatively new field of healthcare, 
drug discovery is accelerated and 
streamlined, virtual nursing assistants 
monitor patients, and big data 
analysis aids in the creation of a more 
personalised patient experience.

	 6.	 The uses of AI in smart homes are :
		  (1)	 Everything at your fingertips.
		  (2)	 Execute customised schedules.
		  (3)	 Talk to or make your home talk.
		  (4)	 Intelligent protection
		  (5)	 Easy access to the mobile 

encyclopedia.

E. Application Based Question
	 1. 	 VR stands for Virtual Reality, which 

is something that does not exist 
physically but can be visualised and 
experiences.

	 2.	 Virtual reality enables the creation 
of real- life simulations in order to 
provide users with an immersive 
experience that makes them feel as if 
they are actually interacting with the 
digital environment around them.

	 3. Car racing games are an example of 
immersive virtual reality that gives the 
user the sensation of speed and driving 
skills.

CHAPTER-10
AI : Challenges and 

Applications
A.	1.	 (a)	 2.	 (d)
	 3.	 (a)	 4.	 (a)        5.	 (a)
B.	1.	 AI
	 2.	 Reinforcement
	 3.	 Von Neumann
	 4.	 The Turing Test
	 5.	 Speech synthesis
C.	1.	 T	 2.	 T
	 3.	 T	 4.	 F 	         5.	 F
D.	1.	 Artificial Intelligence is the ability 

of a digital computer or computer-
controlled robot that can perform tasks 
generally associated with intelligent 
beings. The term is frequently 
applied to the project of developing 
systems endowed with the intellectual 
processes.

	 2.	 (a)	 Eliminate Dull and Boring 
Tasks: An artificially intelligent 
system will perform and continue 
to perform the task that is assigned 
to it, no matter how many times it 
must do so.

		  (b)	Imitates Human Cognition: 
It is referred to as an artificially 
intelligent system because it 
imitates or mimics the way the 
human mind thinks and solve 
problems.

	 3. Chatbots are software that allows a 
conversation with the user to solve 
any problems they are having, either 
through auditory or texting methods. 
These programmes simulate human 
behaviour while conversing with a 
human via an application. Many 



40 Computer Answer Key 1 to 8
businesses, including Swiggy and 
Nykaa, have begun to use chatbots for 
customer service.

	 4.	 There are four types of AI-based 
systems :

		  (1)	Reactive machines: These are the 
most primitive AI systems, with 
extremely limited capabilities. 
They mimic the human mind's 
ability to respond to various 
types of stimuli, Memory-based 
functionality is not available in 
these machines.

		  (2)	Limited Memory: Limited 
memory machines are machines 
that, in addition to having the 
capabilities of purely reactive 
machines, can make decisions 
based on historical data. Almost 
all existing applications that we are 
aware of fall into this category of 
AI.

	 	 (3)	Theory of Mind: While the 
previous two types of AI have been 
and continue to be abundant, 
the next two types of AI exist 
only as a concept or as a work 
in progress for the time being. 
Mental theory AI is the next level 
of artificial intelligence systems 
that researchers are currently 
developing. A theory of mind AI 
will be able to better understand 
the entities with which it interacts 
by determining their needs, 
emotions, beliefs, and thought 
processes.

		  (4)	Self Awareness: This is the 
final stage of AI development, 
which exists only in theory at 
the moment. Self-aware AI is 
an AI that has evolved to be so 
similar to the human brain that 
it has developed self-awareness. 
Developing this type of AI, which 
is decades, if not centuries, away, 
is and will always be the ultimate 
goal of all AI research.

	 5. Turing Test: The Turing test, originally 
called the imitation game was founded 
by Alan Turing an English computer 
scientist, cryptanalyst, mathematician 
and theoretical biologist in 1950, is a 
test of a machine's ability to exhibit 
intelligent behaviour equivalent to, 
or indistinguishable from that of a 
human. It is a method of inquiry 
in artificial intelligence (AI) for 
determining whether or not a 
computer is capable of thinking like a 
human being. The Turing Test judges 
the conversational skill of a bot.

	 6.	 Do Yourself

E.	1. The software engine that drives the 
fourth Industrial Revolution is 
Artificial Intelligence (AI).	

	 2. It holds the promise of resolving some 
of society's most pressing issues.

	 3. Artificial Intelligence face challenges 
such as incomprehensible "black 
box" algorithms, unethical data and 
potential job displacement.

	 4. Its influence is already being felt 
in homes, business and political 
processes.
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